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0BIntroduction 

6BWhat is the 3CX Hotel module? 

 

Screenshot 1 - 3CX Hotel Module 

The hotel module for 3CX Phone System adds additional functions to 3CX Phone System 

to allow it to be used in hotels or other hospitality environments. The hotel module 

performs the following functions: 

• Allows for Check in and Check out of guests 

• Allows setting of guest extensions to Do not Disturb 

• Allows blocking of external calls 

• Allows wake up calls to be scheduled. 

• Allows billing of calls to rooms 

• Allows housekeeping to set room status via the phone 

• Allows minibar usage to be reported via the phone 

The hotel module can integrate with many Hotel software systems / Property 

management systems (PMS) such as Micros Fidelio, Roommaster, Hilton and more. 

Alternatively the receptionist can use the system directly through the provided web 

interface. 

7BComponents 

The hotel module consists of a front end application and a windows service.  

The Windows Service operates in the background and allows for integration with the 

Property Management System. With the integration, many of the functions can be 

triggered from within the PMS software. 
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The Front Desk Phone Control Application is a simple to use windows or web based 

application that allows the front desk clerk to perform the above operations with a few 

mouse clicks. This application can be used separately from, or in tandem with the PMS 

system, and thus requires no integration at all. For many smaller hotels this can be good 

enough.  

8BOperations/functions performed by the Hotel Module 

The hotel module performs the following functions 

32BOperations on Check in 

• Sets Extension Name 

• Unblocks the extension to allow outbound calls 

• Deletes all voice mail messages 

• Clears any Do Not Disturb (DND) functions 

33BCheck out operations 

• Sets name to blank so we can see that there is no one in the room 

• Deletes all voice mail messages 

• Disables outbound calls on extension 

• Clears any Do Not Disturb set 

34BDo Not Disturb (DND)  

• Sets user status to ‘Away’ (same as in interface) 

• All calls will be sent to voice-mail 

35BWake-up Calls 

The system allows for wake up calls to be scheduled. This will call the guest at the 

scheduled time and play a predefined message so as to wake up the guest 

36BBilling 

The system will log calls from each room and show costs based on the cost configured in 

the 3CX Phone System management console. 

The system can output a configurable CDR report for each call. The CDR report can be 

sent to a separate text file (one call per text file) to a text file for all calls (all calls will be 

listed in the same text file, or to a TCP port. For each case, the exact format can be 

customized 
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9BHow it works 

The 3CX Hotel module is an additional module that is installed on the 3CX Phone System 

machine. The module adds an additional service to the 3CX Phone System machine as 

well as a web application.  

The 3CXHotelModuleService starts only if the Hotel is licensed.   

The webserver selection for the 3CX Hotel Module is automatic – this means that if the 

3CX Phone System was installed using the IIS option, then the Hotel Module web 

interface will automatically be on IIS and will be accessed by typing in http://IP/hotel. 

Alternatively, if the 3CX Phone System was installed using the Cassini option, the 3CX 

Hotel module will use Cassini and will be accessed on http://IP:5488.    
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1BInstalling 3CX Hotel Module 

10BDeployment considerations 

Prior to deploying the hotel module, you must install 3CX Phone System and configure it 

as per the documentation. Keep the following points in mind 

• Have the extension numbers match your hotel room numbers. This makes it intuitive 

for guests to dial other room numbers, as well as for hotel staff to identify room 

phones. 3CX Phone System can be deployed with 2,3,4 or 5 digit length extensions 

so it should be possible to match almost any hotel room number 

• If you are replacing an old phone system and want to keep certain numbers such as 

room service or reception using the same shortcuts, keep this in mind when 

assigning extension numbers. 

• It might be advisable to block access to the MyPhone User portal. In that case 

disable port or disable the Myphone User Portal website from the IIS configuration. 

11BSystem requirements 

3CX Hotel module requires the following: 

• Windows XP Pro, Vista, 2003 server or 2008, Windows 7 

• .NET Framework version 2.0 or higher 

• 1 Gigabyte Memory or higher, Pentium 4 processor or up 

• 3CX Phone System 7.1 or higher must be installed and running  

12BInstalling the software 

To install the 3CX Hotel module: 

1. Download the latest 3CX Hotel Module from: 

http://www.3cx.com/downloads/3CXHotelmodule1.msi 

2. Execute setup on the 3CX Phone System machine itself. The 3CX Hotel Module must 

be installed on the same machine as 3CX Phone System. 

3. Now follow the instructions of the Wizard. 

4. You will be prompted to enter a user name and password for the hotel module web 

interface. This web interface will be used by the receptionists of the hotel. It’s a 

shared logon, and does not provide administrative access to the system. 

5. The files will be copied. Click Finish to complete installation. 
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6. Now go to the 3CX Hotel Module web interface: http://<phone-system-machine>/Hotel 

and login with the credentials you specified during setup. Note that the first time you 

start the application it will take up to 15 seconds to load. 

Note: If you installed the Hotel Module on an existing 3CX Phone System installation, you 

need to ‘Check-OUT’ and ‘Check-IN’ the existing extensions to reset the cost counters for 

each extension. All Call Details will be removed for those extensions. 

13BActivating 3CX Hotel module 

Next step is to activate your license. 

1. Start-up the 3CX Hotel Module from the program group that has been created.  

2. Activate your license by going to the File > Activate License page menu option. 

3. Enter your license key, Company, Contact Name, E-mail, Telephone and Country 

and click on “Activate” to activate your license. This information will be sent to our 

license key server and your license key and installation will be activated. You will 

need to do this each time you re-install 3CX Hotel Module or install an upgrade. 

4. Depending on your license key, the product will activate with or without PMS 

integration. 3CXH stands for the hotel module without PMS integration and 

3CHPMS indicates that the license has PMS integration. 

14BCreating a wake up call DR 

The first time you login to the Hotel Module, you will be prompted that you need to 

configure a Digital Receptionist (DR) for the Wake Up call functionality. This is DR is used 

to perform the actual wake up calls. To configure a DR: 

1. Record a file with the text “This is your wake – up call”. Of course you can make the 

text anything you like. For information on how to record sound files, see the 3CX Phone 

System manual. 

2. In the 3CX Phone System Management Console menu, select Add > Digital 

Receptionist.  
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Screenshot 14 - Configuring a digital receptionist 

3. Specify a name and virtual extension number for the digital receptionist.  

4. Now click on the browse button and specify the file that you previously recorded. The 

file will be copied into the 3CXPhone System\Data\Ivr\prompts\ directory. No further 

options are necessary, click OK to save the digital receptionist. 

5. Take note of the Digital Receptionist virtual extension number. Load up the Hotel web 

application by going to the File > Configuration menu option, and next to the option 

“Wake-up Digital receptionist” select the Wake Up Digital Receptionist you just created 

from the drop-down list. In this example you will see 811WakeUpDR. Click the OK button 

to save.  

15BConfiguring Mini bar feature 

3CX Hotel Module provides a mini bar feature that allows Mini bar personnel to 

communicate the mini bar usage to the PMS system via the use of a phone call. To 

configure this: 
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1. In the 3CX Management console, create a Digital receptionist. Call it Dial Code. This 

dummy DR will be used for both the Maid status and the Mini bar features. You do 

not need to upload a Prompt file.  

2. In the 3CX Hotel module interface, go to the configuration dialog and enable the 

‘Dial codes’ and the ‘Use Mini bar Codes’ option. 

3. Select as Digital receptionist: Dial code (the DR you previously created)  

4. Specify a DR Local Port - Choose a high port here – for example 60000 

5. Name Dial Code - put for example *33 here. It must not start with any of the dial 

codes in the Dial Codes Page.  Example: *44 will not work because it will try and 

match the dial code *4 which will take you to Voicemail and not to the Mini Bar. *9 

will not work either because the PBX will think it is a call to Page an extension. 

Therefore a working mini bar code that will work (given you left the dial codes 

default) will be anything starting with *3, *5, *7, *8. 

6. Specify Success Media File and a Failed Media file. Example content would be 

‘Input failed’ and “Input confirmed” 

7. Now under the “Use Minibar codes” section, add the valid Product codes and 

Product names. This way, the system will know that the user has entered a valid 

product code and can give mini bar personnel the appropriate feedback. To be able 

to replenish a minibar that contains a bottle of Sparking water, type Sparking Water 

in the “Product Name” field and in the “Product Code” field enter a code example 10.  

8. Specify the Input order. In this option you specify whether the user types the number 

of units consumed first or whether the product code is entered first. 

a. No of Items * Code means the user has to type no of items first, followed by 

the * and then the product code example 2*10 means 2 bottles of Sparking 

water 

b. Code * No of Items means the user has to type first the product code first, 

followed by the * and then the number of items example 10*2 

The * character for mini bar codes will be used as multiplication character and as a 

delimiter character. 

For example: If two coffees (code 20) and 3 cokes (code 30) need to be inputted and the 

configured dial code name is *33, the dialled number should be: 

*33*2*20*3*30 – if No of Items * Code (a)  

*33*20*2*30*3 – if Code * No of Items (b) 

In both cases, the above syntax means Mini bar order of 2 coffees and 3 cokes 
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2BUsing the Hotel Module Web interface 

16BIntroduction 

This chapter explains how to use the 3CX Hotel module web interface. 

 

Screenshot 2 - The web interface 

The 3CX Hotel Module web interface is located at: http://<phone-system-machine>/Hotel. 

After you login, you will see 4 nodes: 

• All Rooms – All extensions on the phone system 

• Occupied Rooms – These are all extensions for which a name has been set 

• Empty Rooms – All extensions that do not have a name specified 

• Wake-Up Calls – All scheduled wake up calls. 

17BFunctions available 

37BChecking in guests 

 

Screenshot 3 - Checking in a guest 

To check in a guest: 

1. Select the room number from the ‘All Rooms’ or ‘Empty Rooms’ node and click on 

check in icon. 

net-point ag  Bahnhofstrasse 32  CH 6300 Zug  Tel: 041 740 35 35 Fax: 041 740 35 36  http://www.net-point.ch  verkauf@net-point.ch



 
 3CX Phone System for Windows System for Windows www.3cx.com

 

Page 15 

2. You will be prompted for the guest name, email address and caller ID. The email can 

be used for voice mail notification if the guest wishes to receive their voice mail in email. 

3. Click OK. This will: 

• Set the Extension Name to the Guest’s name 

• Unblock the extension to allow outbound calls 

38BChecking out guests 

To check out a guest: 

1. Select the room number and click on the check out icon. 

 

Screenshot 4 - Call costs dialog 

2. The hotel module will bring up the cost of any calls made in a separate dialog. If no 

calls with cost we’re made, a dialog confirming this will pop-up. 

3. You can choose to print this dialog for inclusion with the hotel bill. 

4. Now close the cost dialog. The extension will now be checked out. This will:  

• Delete the guest name and move to room to ‘Empty rooms’  

• Delete all voice mail messages of the room 

• Disable outbound calls on the extension 

• Clear any Do Not Disturbs set 

39BSet to Do not Disturb 

The Do not Disturb function will send all calls to the room to the guest voice mail. The 

DND status will be shown in the DND On/Off column: 

• Available – guest will take calls 

• Do Not Disturb – Calls will be sent to voice mail.  

Note: Do Not Disturb overrides Wake Up calls! 
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40BScheduling a wake up call 

 

Screenshot 5 - Wake up calls 

The wake-up call feature allows you to schedule an automatic call to be placed to a room 

at a particular date and time. To schedule a wake up call: 

1. Select the room number and click on ‘Set Wake up’.  

 

Screenshot 6 - Set wake up call 

2. You will be prompted for the date and time of the wake up call. Click OK to set the 

Wake-Up 

3. When the time of the wake-up call is reached, the guest room will be called 

automatically by the digital receptionist created and transferred to the recorded wake up 

message. Please note that the guest will be called only once. 

 

Screenshot 7 - List of wake up calls 
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4. You can view a list of scheduled wake up calls at any time by clicking on the ‘Wake up 

calls’ node. 

Note: Currently only one wake-up call per extension is allowed. 

41BBlock external calls 

You can block external calls in rooms by selecting the room and selecting ‘Block’. 

42BViewing the calls made by a room 

 

Screenshot 8 - Displaying calls made by guest 

Click on the room number and ‘View calls’ to view all the calls made by a particular room 

and the associated cost. You can print this data by clicking print. 

43BSet room status by phone 

This function allows cleaners to set the status of the room via the phone. The maid status 

message is triggered by a call from the room in question and by entering the special 

feature code (special dial code set in the hotel interface), followed by the appropriate 

code to specify the status of the room. 

For example: 

Dialing “*332” from the room will trigger a maid status message to the PMS that will set 

the status of the room to clean. In this example *33 is the special feature code 

(configurable) and 2 is the status code ‘clean’. 

The following values can be entered 

1       maid present 

2       clean 

3       not clean 

4       out of service 

5       to be inspected 

6       Occupied/Clean 

7       Occupied/Not Clean 
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8       Vacant/Clean 

9       Vacant/Not Clean 

If the code is correct, the success media file message will be played. If the code is 

incorrect the failed media file message will be played. These messages can be 

configured from the hotel interface File > Configuration > Use Dial Codes Section. These 

are the same files that are used for the Minibar codes.   

44BEntering Minibar usage 

The minibar function allows minibar personnel to forward minibar usage to the PMS 

system via the phone. Personnel pick up the phone from the room in question example 

Room 100 (which will have extension 100) and dial the special dial code, followed by the 

appropriate item code and the amount. For example: 

*33*2*10 

will notify the PMS that the minibar in room 100 needs 2 units of item code 10.  

If the code is correct, the success media file message will be played. If the code is 

incorrect the failed media file message will be played. These messages can be 

configured from the hotel interface File > Configuration > Use Dial Codes Section. 
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3BHotel software / PMS integration 

18BIntroduction 

Although all hotel - related functions can be performed via the web interface, it is often 

preferable to perform these functions automatically at check in or check out of the guest 

via the Property Management System software. 

3CX Phone System supports a wide range of hotel software systems. 

19BIntegration options 

The 3CX Phone System hotel module can integrate with PMS systems in the following 

ways: 

1. Via the 3CX PMS protocol. This protocol is very similar to the Mitel protocol. Most 

hotel software has a Mitel PBX interface so it is possible to select this integration 

option in the Hotel Software and it will work with the 3CX PMS protocol. If multiple 

Mitel options are offered, the Mitel SX 2000 option must be selected. 

2. Via the Fidelio protocol 

3. Via middleware software called Lodging Link. Lodging link integrates with 

numerous hotel software systems and provides transparent integration with the 

3CX PBX hotel module. Supported hotel software systems included can be found 

here: HUhttp://www.comtrol.com/aboutus/partners/hospitality/pmsU 

4. Exchange of data can also be done on a custom basis. In this scenario, 

documentation must be provided by the reseller how the integration must be 

performed. Additional charges may apply. 
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20BConfiguring 3CX PMS protocol integration 

When using the 3CX PMS protocol, the 3CX Hotel module acts as a server. In other 

words, the PMS software sends messages to the 3CX Hotel Module. Therefore there is 

nothing to configure at the 3CX side, unless you want to change the default ports. In the 

PMS software you must specify: 

1. The IP of 3CX Phone System. 

2. Specify port 15374 for the Hotel Software connection 

3. Specify port 6830 for the Voice Mail connection 

4. If multiple Mitel options are offered, choose Mitel SX 2000 

Naturally, if you change the default ports, you must change them in the PMS system as 

well. 

The 3CX PMS protocol acts as a TCP server 

21BConfiguring Fidelio protocol integration 

Specify the IP and the Port of the PMS server in the Web interface, by going to File > 

Configuration and selecting ‘Fidelio’. Now specify the IP and port of the Lodging Link 

server 

The 3CX Fidelio protocol integration acts as a TCP client 

22BConfiguring Lodging link integration  

Lodging Link eliminates the need for property management system (PMS) vendors to 

create their own interfaces for each hardware device. Such as PBX, voice mail, call 

accounting, in-room Internet access, point-of-sale, in-room movie, keyless entry, mini-bar, 

and energy management systems. 

To configure Lodging Link for use with 3CX Phone System 

1. Install Lodging Link PTS or Premier according to the product documentation. This 

product might already be installed, please contact your hotel software vendor for 

more information. 

2. Specify the IP and the Port of the Lodging Link server in the Web interface, by 

going to File > Configuration and selecting ‘Lodging Link’. Now specify the IP and 

port of the Lodging Link server 

The 3CX lodging link integration acts as a TCP client 
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4BConfiguring the billing interface 

23BIntroduction 

3CX Phone System provides billing information so that you can charge your guests 

accordingly for each phone call. This information is displayed per room in the web 

interface, or alternatively you can output it to a text file or to TCP port so that you can 

integrate it with your PMS software. 

Call costs are calculated and inserted into a CDR (Call Data Record) which is outputted 

to disk as a text file or sent to a particular host at a particular port. In this manner it is 

easy to integrate with a hotel software system or call accounting software. 

24BAdjusting Billing costs 

3CX Phone System calculates call costs based on destination number and call duration. 

You will need to enter the cost for each country, for national calls and for mobile calls. 

The default billing rate is 1.0. To change these rates 

1. In 3CX Management Console, go to ‘View > Billing Information’  

2. Edit the rates as appropriate and click ‘Apply’. 

3. When calls are made to external numbers, they are checked against this prefix table. If 

a match is found then the cost is calculated as follows: TotalCost = Talking time * rate 

where a rate of 1.0 means 100 per 60 seconds of talking time (1 minute) 

 

 

 

 

 

 

 

 

 

 

 

 

          Screenshot 9 – Billing Information in the 3CX Management Console 
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25BCDR Output 

The CDR feature provides three output channels. 

1. One file for all calls 

2. One file per call 

3. Socket output 

 

Each channel can be enabled separately. To Enable the CDR feature, from the 

management console go to the ‘Settings > advanced page’, and select the ‘CDR Output’ 

tab.  

26BChanging CDR output location 

The file output default location can be changed by editing each template file. The 

template files are located in: 

1. One File: %allusersprofile%\Application Data\ 3CX\Data\Logs\CDRSingle\  

2. Per Call: %allusersprofile%\Application Data\ 3CX\Data\Logs\CDRMulti\  

3. Socket: %All Users%\Application Data\3CX\Data\CDRTemplates\CDRTemplate-

Socket.xml 

In the case of socket output, the host name and port must be specified in the tags 

“Host="127.0.0.1" Port="33555" 

All output is text based and can be formatted by modifying the template for each channel.  

The templates default location is here: %allusersprofile%\Application 

Data\3CX\Data\CDRTemplates  

27BEditing CDR output format 

If you need to alter the format with which the CDRs are outputted, you can do by editing 

the XML template files. Each template file contains XML tags that describe which 

database fields should be included in the CDR, in which order and how each field should 

be formatted. 
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Each node outputs the text quoted in the text after “{0}” and is replaced by the value of 

the actual field. For example, the xml node 

<CallerID fmt=”XX caller ID={0} XX" /> 

Would output: 

XX caller ID=00357999999 XX 

The formatting can be customised using C# formatting strings. So it is possible to insert 

text before and after a field value and to format numbers with decimals and format dates. 

Here are some examples: 

Formatting the TotalCost field: 

<TotalCost    fmt="CallCost = {0:000.00}," /> 

Output:    CallCost = 003.40, 

<starttime fmt="{0:ddMMyyHHmmss}," /> 

Output:  311209235959, 

<starttime fmt="{0:dd/MM/yyyy HH.mm.ss}," /> 

Output:  31/12/2009 23.59.59, 

Adding new line characters in XML 

<NumDetails   fmt="Call details = {0}&#xD;&#xA;" /> 

Output: Call details = 2<CR><LF> 

CR = &#xD;  LF = &#xA;  (CR – carriage return LF – line feed) 

Each call has one main Callhistory3 entry and 1 or more CallDetails entries. Each Call 

Detail is for one destination of the call, so if a call is transferred 2 times, there will be 3 

call details records for it: one for the initial destination and one for each transfer. 

45BComplete CDR template 

Below are the complete contents of a CDR template. It includes all the possible fields. 

Fields that are not required, can be removed by removing the corresponding xml node.  

<?xml version="1.0" encoding="utf-8"?> 

<CallTemplate Folder="3CX\Data\Logs\CDRSingle\" FileName="calls.txt" > 

  <idcallhistory3 fmt="&#xD;&#xA;Call {0}," /> <!-- comments get skipped --> 

  <callid   fmt="{0}," /> 

  <duration fmt="{0}," /> 

  <starttime fmt="{0:ddMMyyHHmmss}," /> <!-- use dot net string formating to format the 

date --> 

  <answertime fmt="{0}," /> 

  <endtime  fmt="{0}," /> 
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  <from_no  fmt="{0}," /> 

  <to_no    fmt="{0}," /> 

  <group_no fmt="{0}," /> 

  <line_no  fmt="{0}," /> 

  <is_answ  fmt="{0}, " /> 

  <is_fail  fmt="{0}," /> 

  <is_compl fmt="{0}," /> 

  <is_fromoutside fmt="{0}," /> 

  <CallerID fmt="{0}," /> 

  <DialedNumber fmt="{0}," /> 

  <lastCallerID fmt="{0}," /> 

  <lastDialedNumber fmt="{0}," /> 

  <mediaType fmt="{0}," /> 

  <Rate         fmt="{0}," /> 

  <TotalCost    fmt="{0}," /> 

  <BillPrefix   fmt="{0}," /> 

  <BillRateName fmt="{0}," /> <!-- add cr/ new line in the string --> 

  <RecFile   fmt="{0}," /> 

  <GrpAnswDetail fmt="{0}&#xD;&#xA;" /> 

  <NumDetails   fmt="{0}&#xD;&#xA;" /> 

 

  <DetailsTemplate> 

      <DetailNum fmt="CallDetail {0}," /> 

      <IdCallHistory2  fmt="{0}," /> 

      <ParentDetailNum fmt="{0}," /> 

      <dest_dn  fmt="{0}," /> 

      <dest_num  fmt="{0}," /> 

      <StartTime fmt="{0}," /> 

      <Dur       fmt="{0}," /> 

      <AnswerTime fmt="{0}," /> 

      <Status    fmt="{0}," /> 

      <Is_Compl  fmt="{0}," /> 

      <SpecDstType fmt="{0}," /> 
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      <is_tooutside fmt="{0}&#xD;&#xA;" /> 

  </DetailsTemplate> 

</CallTemplate> 

28BSMDR output 

The SMDR feature is separate from the other CDR features. 

46BEnabling SMDR 

To enable it you must enter the host and port to Listen on for incoming connections. In 

the Parameters SMDRHOSTPORT parameter. SMDRHOSTPORT=“0.0.0.0:1752” should 

work for most cases where only 1 network connection exists. 

To disable it you must set an empty host, e.g. SMDRHOSTPORT=“” 

 

SMDR will wait for incoming connections on the port specified, and will output each call in 

SMDR format to all established connections. The default format is compatible with Mitel 

SX 2000, and has been tested with “Call Accounting Mate” software.  

The 3rd party software has the responsibility to connect and to maintain the socket 

connection to the SMDR service.  

47BCustomizing SMDR output 

It is also possible to customize the output by editing the C# script that produces this. It 

can be found at: 

%allusersprofile%\Application Data\3CX\Data\CDRTemplates\SMDR.cs 

Changing the script requires knowledge of C# or at least programming skills. The script 

has access to 2 objects, ‘callinfo’ and ‘details’. 

callinfo: contains information regarding the entire call. It has access to the following fields: 

 public int nHistoryID; 

 public TimeSpan tmDuration; 

 public DateTime tmCallStart, tmCallAnswered, tmCallEnded; 

 public String sCallFrom, sCallTo, sGroupNum, sLineNum, sRecCallID, 

               sCallerID, sDialedNumber, sLastCallerID, 

               sLastDialedNumber, sBillPrefix, sBillRateName; 
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 public bool bIsAnswered, bIsFailed, bIsCompleted, 

             bCallFromOutside, bMakeCallOrigin; 

 public Double fRate, fTotalCost; 

 public cnDnKind  eGroupType; 

 public int iMediaType, iNumDetails, iGrpAnswer; 

 

details: is a list of destinations for that call. E.g. in the case of transfers it may have 

multiple details. 

To iterate through all the details : 

foreach(DetailData3 dd in details) 

{ 

  Ret += dd.DestDN; 

} 

 

And finally the script has to return the output string: 

 return ret.ToString(); 

The details object has the dollowing info available: 

public class DetailData3 // holds details for one call 

{ 

 public int ParentIdx; 

 public String DestDN, DestNum; 

 public DateTime StartTime, AnswerTime, EndTime; 

 public TimeSpan Dur; 

 public cnStatus Status; 

 public bool IsCompl, IsMediator, bCallToOutside, bFromExtNum; 

 public cnSpecType SpecType; 

 public int iIdCallHist, iNDetail, ExtType; 

}  

For a more extensive example please look into SMDR.cs 

%allusersprofile%\Application Data\3CX\Data\CDRTemplates\SMDR.cs 
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5B3CX PMS protocol specification 

29BIntroduction 

This chapter details the 3CX PMS protocol, which integrates with PMS hotel software. 

The 3CX PSM protocol closely resembles the Mitel PMS protocol, and therefore its 

possible to specify the Mitel PMS protocol in the PMS system. The protocol is further 

detailed in this chapter. 

30BGeneral Protocol information 

The PMS/System bi-directional (through half-duplex) link uses the ENQ /ACK/STX-text-

ETX/ACK protocol. The PMS to system transmission sequence is :  

 

The transmission of the message is complete. 

There are timing restrictions imposed on the transmission sequences:  

  

The maximum time to wait for the ACK after a STX + msg + ETX transmission is 3 

seconds. 

48BPMS to System Transmission  

After receiving an ENQ character from the PMS, the system responds within three 

seconds with either an ACK or a NAK. The ACK indicates the transmission was 

successful. The NAK indicates there was a transmission error, or that the system is busy. 

The system generates a hotel log indicating such an error occurred. After sending the 

ACK, the system is immediately ready to receive the STX, message text, and ETX. Within 

three seconds of receiving the ETX, it responds with either:  

• .ACK indicating the transmission was successful, and all of the message fields are 

valid.  
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• .NAK indicating there was an error in either the transmission itself, in one of the 

message fields, or in the syntax of the message (specifically STX, ETX, function 

code and status code; for example, CHK3 is sent instead of CHK1). The system 

generates a hotel log indicating this error occurred. The PMS is able to retry sending 

only the message txn (STX, message text and ETX) three more times without 

prefacing it with an ENQ message first.  

The following example illustrates a PMS transaction retry:  

  

The PMS then discards the transaction. 

31BPMS Format Specification  

The messages have the following general format: 

 

49BCheck In/Out Messages  

The message has the following format:  

 

where: X is the Check In/Out status code  

• ASCII character 1 for Check In  

• ASCII character 0 for Check Out  

SP is the ASCII blank character. n is an extension number digit.  

Note that extension numbers less than five digits long are filled with space characters 

(ASCII 32, HEX 20), not zeros (ASCII 48, HEX 30).  
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If the message received from the PMS is invalid, the system returns a NAK (an ASCII 

character for Negative Acknowledge). 

Example: 

Check In: (check in for extension 100) 

STXCHK1   100ETX(where STX = 2, ETX = 3) resulting the following message 2CHK1   

1003 

50BName Message 

This message is sent from the PMS and is used to display the Guest name on the phone. 

The Name message has the following input format:  

 

where : 

NAM is the name function code.  

NAME is a character of the name (maximum 21 characters).  

n is an extension number digit.  

The length of the name (up to 21 characters) is left-justified, with blanks used for padding. 

The characters can be upper or lower case, and may also include numeric characters. 

First and last names may be given (separated by a comma placed anywhere but in the 

1st and 21st location), but if only one name appears it is recorded as the surname by 

default. The first name in the string must be the last name or surname, followed by the 

first name. If only one name is given, the 21st character is a blank (the maximum size of a 

name is 20).  

Use of the string operation code allows for addition and deletion of a specific name 

against an extension.  

The system allows more than one name to be added against a station. Most situations 

usually have just one name associated with a station number.  

The String Operation code is the first byte of the status code, and may be one of these 

options:  

1. (addition) - The name is ADDED to the current list of names against this station. If 

there is no name against this number, a new telephone directory entry is created.  

2. (replacement) - The name is used to REPLACE the first alphabetical name against 

this number. All other names against this number are not altered  

If an invalid message is received from the PMS, the system returns a NAK. 

51BWake up messages 

The PMS system can inform the system when to set a wake-up call for a particular guest 

station. The Wake-up message has the following output format: 
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where: t is the wake-up time. n is an extension number digit.  

The wake-up time is specified in 24 hour time. All four characters, filled with ASCII blanks, 

represent a deletion of the wakeup time(time format: HHmm).  

Example of wake-up call at 23 and 30 minutes to extension 100: 

2MW 2330 1003 

52BDND Message 

The PMS system can inform the PBX when to set the DND status for a particular guest 

station by sending the following message. 

The DND message has the following format. 

 

Where STATUS CODE: 

1 – DND ON 

0 – DND OFF 

SP is the ASCII blank character. 

Example: set DND ON for extension 302 

2DND1   3023 [ STXDND1SPSPSP302ETX 

StxValue = 2 

EtxValue = 3 

ENQ = 5; 

ACK = 6; 

NACK = 21 

53BMessage Registration Message 

Each time a hotel extension makes a trunk call, the system sends a message to the PMS 

to update the total count of outside calls made against the guest room. No distinction is 

made between local and long-distance calls. Message Registration works by counting the 

number of meter pulses made over the duration of the call.  

The Message Registration message has the following output format:  
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where:  

SP is the ASCII blank character.  

n is an extension number digit.  

The status code in this case is a fee or peg count. This is the one exception to the length 

of the status code, being 4 bytes instead of 2. 

54BMessage Waiting Message 

The format of this message is the same for both directions. The format of the message is 

similar to the check in/out message where the use of binary status code provides the new 

state of the message waiting lamp.  

The Message Waiting message has the following format:  

 

where : SP is the ASCII blank character. X is the Message Waiting Lamp status code  

• ASCII character 1 for Lamp On  

• ASCII character 0 for Lamp Off n is an extension number digit. 

55BStation Restriction Message 

A Station Restriction message can be used to establish call restrictions. When this 

message is sent from the PMS to the system, it brings previously programmed Call 

Restrictions into effect. 

Note: Emergency Services (911/999) and internal calls are never restricted. 

The Station Restriction message has the following format: 

 

where : RST is the Station Restriction function code X is an extension or suite number 

digit S is one of the following status codes:  

. • 0 - Internal  

. • 1 - Local  

. • 2 - Long Distance  

StxValue = 2 

EtxValue = 3 
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ENQ = 5; 

ACK = 6; 

NACK = 21 

56BMaid Status Message 

The maid status message is used to allow cleaners to set the status of the room via the 

phone. The maid status message is triggered by a call from the room in question and by 

entering the special feature code, followed by the appropriate code to specify the status 

of the room. 

For example dialing “*332” from the room will trigger a maid status message to the PMS 

that will set the status of the room to clean. 

The Maid Status Message has the following format: 

STX S T S X SP n N n n n ETX 

 

X is the maid status code 

SP is the ASCII blank character 

n is the station number digit(up to 5 digits) 

When a Feature code is dialled, the system sends both a Function and Status code to the 

PMS, and the PMS interprets the codes in the following way: 

Message Occupancy Condition 

STS1       maid present 

STS2       clean 

STS3       not clean 

STS4       out of service 

STS5       to be inspected 

STS6       Occupied/Clean 

STS7       Occupied/Not Clean 

STS8       Vacant/Clean 

STS9       Vacant/Not Clean 

57BMinibar message 

The minibar message allows minibar personnel to forward minibar usage to the PMS 

system via the phone. The minibar message is triggered by a call from the room in 

question and by entering the special feature code, followed by the appropriate item code 

and the amount. For example 

*33 (special dial code set in the management interface) 10*2. 

Will send to the PMS that the room had 2 units of item code 10  
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If the code is correct, a success message will be played. If its incorrect an error message 

will be played. These messages can be configured from the interface. The correct minibar 

item codes can be configured from the hotel management interface. 

The minibar message has the following format: 

STX M N B SP c c c c c(30) n n n n n ETX 

  
nnnnn the extension number 

cccccc data lenght 30 digit, can be filled with 0-9,* 

'*' character has two roles: delimiter and multiplication  

example: a minibar request from extension 100 

[STX]MNB[SP]1*20*3*50[SP..SP][SPSP100][ETX] 

means posting code item 20 (cocacola) with a total of 1 pcs and item code 50 (chocolate) 

with a total of 3 pcs. 
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